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Chapter 3 − Contracts
Chapter 3. Contracts

The B2Gnow contract record contains the data collected between your organization and the
prime contractor for construction, goods, or other types of services. In some situations we
import contracts electronically into B2Gnow from an external system; in others the records are
manually entered. The B2Gnow contract record manages common contract data, such as
contract dollar value, prime contractor, and relevant dates. It also manages data specific to
your contract compliance tracking and reporting needs. This data includes goal types, goal
percentages, funding sources, subcontractor awards, and other relevant fields.
The B2Gnow contract record contains a large amount of data and is linked to other system
records including prime contractors, subcontractors, buyers, and Contract Compliance Officers
(CCO). The contract record and associated records are typically managed by the CCO.

Understanding the Contract Compliance Officer (CCO) Role
The CCO plays a critical role in the B2Gnow system by managing the contract record. The CCO
is responsible for making sure that contract data has been imported or entered correctly into
B2Gnow. Once the contract record is configured in B2Gnow, the CCO monitors contract audits
and data to guarantee that accurate data is created and reported. This chapter contains the
information needed by the CCO to properly create and manage their contract records.

Creating contracts
During the implementation process, B2Gnow configures your contract fields and settings based
on your organization’s preferences. You can create contracts directly in the system or your
organization may have an interface that imports records from an external system (see the
B2Gnow Data Import Process).
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To create a contact
1. Open the Create menu, and then click New Contract.
2. Complete the form.

NOTE:

Page 3‐2

Some fields and options may be different based on your organization’s configuration.
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3. To verify information, click Review.
4. Click Save.

Searching for and viewing contracts
You can complete a search for your contracts or quickly view your contract list. After locating
the contract you want to work with, you can open it to view and update the contract details.

Searching for contracts
To complete a search, enter or select search parameters on the Search: Contracts page. You
can complete a search as broad or narrow as you want. For example, you can search for all
contracts assigned to your department or only search for contracts assigned to you.
To search for a contract
1. From the Search menu, click Contracts.
2. Enter or select search parameters. For search tips, see Chapter 1 – System Overview:
Tips for performing searches.
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3. Click Search First 20 Matches.
The matching results display. You can click a contract number or title to view more
information about a specific contract.
To view contract record details from a search
1. Search for and locate the contract you want to view.
2. To access the contract main page, click the Contract Number, Contract Title, or
System Transaction #.

3. To view the vendor profile, click the name of the Prime Contractor.
The Vendor Profile displays in a popup window.
4. To access the Contract Management: Subcontractor List page, click the Subs
hyperlink.
5. To access the Contract Audit: Audit Summary for Total Contract page, click the Audit
hyperlink.
Additionally, you can perform actions after completing a search, such as sending a contract
letter or adding the prime contractors from the search results to an outreach campaign.
To perform actions after a contract search
1. Search for the contracts for which you want to perform an action.
2. To return to the Search: Contracts page, click Search Again.

3. To compose a letter or select a letter template to send, click Send Contract Letters,
and then click OK.
NOTE:

If you selected the contract goal status search parameter, the button is Send Not
Meeting Goal Letters.

4. To export the list, click Export, and then specify the details you want to export and
click Export Records. If prompted, follow the browser instructions for saving the file.
5. To send a message to all prime contractors listed in the search results, click Message
Contract Contacts and complete the fields to send the message, as necessary.

B2Gnow Support  support@b2gnow.com

Page 3‐7

CONTRACTS

6. To add prime and sub contractors listed in the search results to an existing outreach
campaign, click Add Primes & Subs to Outreach Campaign, click OK, and then
complete the fields, as necessary.
7. To add only the prime contractors listed in the search results to an existing outreach
campaign, click Add Only Primes to Outreach Campaign, click OK, and then complete
the fields, as necessary.
8. To add only the sub contractors listed in the search results to an existing outreach
campaign, click Add Only Subs to Outreach Campaign, click OK, and then complete
the fields, as necessary.
To search for your contracts
1. From the Search menu, click Contracts.
2. From the Contract Compliance Officer list, select your name.

3. Click Search All Matches.
A list of your contracts display. You can click a title to view more information about a
specific contract.

Viewing your contract list
From the Data Dashboard, you can easily view information about your contracts, such as the
number of active contracts and audits. You can also access the Diversity User Control Panel:
Contracts page to view and sort through your contract list.
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To view your contract list and contract details
1. From the Data Dashboard, click the Contracts hyperlink.

2. Use the lists to filter the number of contracts that display.

3. To view contract details, click the View hyperlink.

Working with the Contract Management page
After opening the contract you want to view, you can use the tabs on the Contract
Management window to navigate and perform actions for different sections of the contract.
For example, you can navigate to the Subs tab to add or edit a subcontractor, complete
actions for prime contractors, and communicate with contractors.
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Viewing the Contract Management page
When you open the contract, the Contract Management page displays with the Main contract
tab open. You can view basic contract information, alerts, and status history, and access
hyperlinks for updating and changing your contract’s alerts and status.
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Viewing detailed contract information
On the Contract: View page, you can view contract details, including settings and file
attachments. You cannot update information from this page.
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Managing contract settings
On the Contract: Settings page, you can view and update the information that governs the
contract, compliance audit, and workforce/prevailing wage settings (if configured).
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Managing subcontractors
On the Contract Management: Subcontractor List page, you can add and manage
subcontractors for the contract.

Identifying the prime contractor and the subcontractor
The prime contractor and subcontractor are easy to identify. The prime contractor is listed at
the top of most pages in the Contracts module. You can view the full details of every vendor
associated with the contract on the Subcontractor List.
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Adding a subcontractor to a contract
You can add multiple subcontractors to contracts.
To add a subcontractor to a contract
1. From the Contract Management page, click the Subs tab.
2. Click the Add Subcontractor button.

3. In the Vendor field, type the name of the vendor and select it from the list, or click Get
Vendor and complete a search for the firm.
 Vendor: Select a vendor to auto‐populate vendor information.
 Vendor Compliance Contact: Select a compliance contact.
 Vendor Address: Select the vendor’s address.
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4. Fill in the Contract Information box.
 Subcontractor Tier: Select the firm to which the vendor reports.
 Reference Identifier: Add information that displays on the subcontractor lists.
 Contracted Percent & Amount: Specify the percent or amount for the vendor.
 Type of Participation: Select the item that reflects the vendor’s type of
participation for the contract.
 Starting Paid to Date: Enter amount paid as of the date displayed.
 Final Amount Adjustment/Paid Retainage: Specify if the subcontractor was
paid retainage by the prime contractor or if you made another adjustment at
the end of the contract.
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5. Fill in the Settings box.
 Include in Compliance Audits?: Select Yes or No for tracking payments.
 Count Towards Certified Goal: If Yes, select the type.
 Goal Type: Select the certified goal type.
 Add vendor to existing audits for this contract?: If Yes, the firm is added to
prior audits so that payments can be back entered.
 Final Payment Made?: Select whether the final payment was made for the
contract.
 Subcontract Award Date: Specify the subcontractor’s start date.
 Work Start Date: Specify the date on which the actual work began.
 Work End Date: Specify the date on which the actual work ended.
 Work Description: Enter the type of work performed.
 Commodity Codes: Add codes, as needed.

6. Click Review and verify the information.
7. Click Save.

Approving subcontractor requests
Your organization may permit prime contractors to self‐request additional subcontractors.
Prime contractors can search the vendor directory and indicate how they intend to utilize each
subcontractor. If you have the authority, you can either accept or deny the request. If not, you
can record your recommendation.
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To approve a subcontractor request
1. To access subcontractor requests from the dashboard, in the Sub Requests line, click
the red number.

2. To access subcontractor requests from the navigation menu, open the View menu, and
then click Sub Requests.
3. Click the contract number.

4. Review the request.
5. Click Approve Request.
6. Click OK to confirm you want to navigate to the next page to review and confirm the
request.
7. Click Review.
8. Click Save.
If you are not authorized to take action, the system records your recommendation and the
request remains open.

Page 3‐18

B2Gnow Support  support@b2gnow.com

CONTRACTS

Certified, self‐performing prime contractors
If a prime contractor is certified and will be counted towards the goal, the contract must be
updated to reflect this status. The system tracks payments to certified, self‐performing prime
contractors using one of two methods:
Method 1: Calculated Remaining Amount
Payments to the prime contractors are calculated as the remaining amount after payments are
made to all certified and non‐certified subcontractors. This method requires that all
subcontractors are tracked. For example:
Payment to prime contractor:
Payment to certified subcontractor:
Payment to non‐certified subcontractor:
Remaining amount:
Amount counted to prime contractor:

$1,000,000
$100,000
$150,000
$750,000
$750,000

Method 2: Separate Payment Tracking
Payments to the prime contractor are specifically reported and recorded on a separate line and
are not derived from any other data. This method is used if not all subcontractors are tracked,
specifically non‐certified contractors. For example:
Payment to prime contractor:
Payment to certified subcontractor:
Remaining amount:
Payment to certified, self‐performing prime contractor:
Amount “missing” from report (non‐certified subcontractor):
Amount counted to prime contractor:

$1,000,000
$100,000
$900,000
$750,000
$150,000
$750,000

To use Method 1: Calculated Remaining Amount
1. If necessary, locate and open the contract.
2. On the Contract Management page, click the Subs tab.
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3. In the Prime Contractor box, from the Select Action list, select Edit Prime.

4. On the Contract Management: Edit Prime Contractor page, change the Count
Towards Certified Goal to Yes and select the Goal Type.

5. Click Review.
6. Click Save.
The Prime Contractor box will reflect that the prime is counted for credit.
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To use Method 2: Separate Payment Tracking
1.
2.
3.
4.

If necessary, locate and open the contract.
On the Contract Management page, click the Subs tab.
Click the Add Subcontractor button.
Complete the process as if adding a subcontractor, but use the following settings:
 Contracted Percent & Amount: enter the percent or amount of the contract the
prime contractor will be self‐performing.
 Type of Participation: Select Self‐Performing Prime Contractor.
 Include in Compliance Audits?: Yes
 Count Towards Certified Goal: Yes.
 Goal Type: Select the goal type.

5. Click Review.
6. Click Save.
The Subs tab on the Contract Management: Subcontractor List page displays information
about the self‐performing contractor.
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Managing documents
On the Contract Management: Documents page, you can view a list of documents saved to
the contract record, open documents, and add documents.

To add a document
1. If necessary, locate and open the contract.
2. On the Contract Management page, click the Docs tab.
3. Click Add Document.
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4. From the Record list, select the record associated with the document you want to
attach.

5. Click Browse, and then locate and select the file.
6. In the Document Title and Document Description fields, enter the title and a
description of the document.
7. Click Add Document.
8. Click OK.
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Managing change orders and task orders
On the Contract Management: Associated Records List page, you can manage change orders
to the contract, which includes changes in the value and/or end date of the contract.
Contracts can also be linked together to create Master Contract – Task Order relationships.
This is used for job order contracting, release contracting, oncalls, multi‐phase project (design
& build), and other complex situations. Each record has its own prime, subcontractors, goals,
settings, and payments. If you are on a Master Contract or Task Order, the Master Audit
Summary tab displays, and you can click the tab to view an aggregated summary of all linked
records.

Creating change orders
You can use the Change Orders & Task Orders tab to change a contract’s value or end date.
When you change the value, you create an amendment to the existing contract that allows
you to change the total value of the original contract and specify new values for meeting
goals. You can also specify the percentages or amounts of the contract that will go to
subcontractors.
When you change the contract’s end date, you can end the contract on an earlier or later
date than the current date on the contract.
To change the value of a contract
1. If necessary, locate and open the contract.
2. On the Contract Management page, click the Change Orders & Task Orders tab.
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3. Click Change Contract Value.

4. In the Amendment Title field, enter the title of the amendment.

5. From the Amendment Date calendar selector, select a date for the amendment.
6. In the Amendment Note field, enter additional information about the amendment.
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7. In the Contract Amendment area, specify whether you are creating an amendment
for The new TOTAL contract amount or The ADDITIONAL amount for the contract,
and then enter the amount.

8. In the New Goal(s) area, specify whether you are creating an amendment for The
percent of The TOTAL new contract amount or The percent of the ADDITIONAL
contract amount, and then enter the Required Goal, Proposed/Committed Goal,
Waiver, and Actual Goal percentages for each category.
9. In the Subcontractors box, enter the Percent/Amount of the ADDITIONAL contract
amount, Percent/Amount of the TOTAL new contract amount, and any Comments
for each subcontractor.

10. Click Review, and then click Save.

Page 3‐26

B2Gnow Support  support@b2gnow.com

CONTRACTS

To change the end date of a contract
1. If necessary, locate and open the contract.
2. On the Contract Management page, click the Change Orders & Task Orders tab.
3. Click Extend/Shorten Contract.

4. From the Extend/shorten contract to calendar selector, select the date on which the
contract ends.

5. Click Review, and then click Save.

Linking contract records
You can create a task order from another contract record and link it to a master contract.
When multiple records are linked, the Master Contract Audit Summary appears to display a
roll‐up summary of all awards and payments across all linked contract records.
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To link a task order to a master contract
1. If necessary, locate and open the contract.
2. On the Contract Management page, click the Change Orders & Task Orders tab.
3. Click Link Existing Contract As Task Order.

4. Click Select a Contract to Link.

5. Search for and select the contract you want to link.
6. To link the selected record as a task order on the master contract, click Link Record.
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To unlink a task record from a master contract
1. On the Contract Management: Associated Records List page, click Unlink.

2. Click OK to confirm you want to remove the link to the master contract.

Managing contract alerts
On the Contract: Alerts page, you can add alerts for contracts and subcontractors. After you
add alerts, you can view, edit, or delete them.

To add a contract alert
1. If necessary, locate and open the contract.
2. On the Contract Management page, click the Alerts tab.
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3. Click Add New Alert.

4. Select the type of alert you want to configure.
Depending on the type of alert you selected, different fields display.
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5. To configure a general alert, click General alert, and then complete the following:
Recipient(s): Select the check box to send an alert to yourself. Click add more
recipients to use check boxes to send alerts to others.
Trigger Date: Use the calendar selector to specify the day on which you want to send
the alert.
Alert Note: Enter the information you want to include in the alert.
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6. To configure an alert prior to the end of the contract, click Contract end alert, and
then complete the following:
Recipient(s): Select the check box to send an alert to yourself. Click add more
recipients to use check boxes to send alerts to others.
Days Prior to End Date: Specify the number of days prior to the contract’s end date
that you want to send the alert.
Alert Note: Enter the information you want to include in the alert.

7. To configure an alert about prime contractor payments exceeding the specified
progress level, click Contract progress alert, and then complete the following:
Recipient(s): Select the check box to send an alert to yourself. Click add more
recipients to use check boxes to send alerts to others.
Progress Percent: Enter the percent at which the alert is triggered.
Alert Note: Enter the information you want to include in the alert.

8. Click Save Alert.
Page 3‐32
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Managing comments
On the Contract Management: Comments page, you can add and work with comments.
Comments can be added to a contract to make notes, set up alerts, and trigger reminders.
Any comments associated with a specific contract display in a list on the Comments tab. You
can add comments, edit or delete existing comments, and, if a comment was assigned a due
date, view and save it to your calendar.

To add a comment to a contract
1.
2.
3.
4.

If necessary, open the contract to which you want to add a comment.
Go to the Comments tab.
Click Add New Comment.
In the Comment Type area, specify whether you want to add a Standard Comment or
Comment with Due Date.

5.
6.
7.
8.

If necessary, from the calendar selector, select the due date.
To create a Comment with Due Date alert, select Add an alert for this comment.
In the Comments area, enter your comment.
Click Save Comment.

Comments display in the list.
TIP:

Comments that are created as an alert will be triggered on the selected Due Date
and an email alert sent to you. The alert will also be shown on your dashboard.
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To edit or delete a comment
1. To edit a comment, click the Edit hyperlink for the comment you want to update, edit
the comment, click Review, and then click Save.

2. To delete a comment, click the Delete hyperlink for the comment you want to delete,
and then click OK.
To view and save a comment to your calendar
1. If a comment has an associated Due Date, to add it to your calendar, click the
Calendar hyperlink.

2. Click OK to confirm you want to open and save it in your calendar.
3. Save the comment using your calendar’s tools, which vary depending on the calendar
software you use (e.g. Microsoft Outlook).

Viewing & sending messages
On the Contract Management: Messages page, you can view all messages sent for this
contract. You send messages through areas in the contract where a contact’s name displays
as a hyperlink or a Message button displays for sending messages.
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Sending messages
When the system is used to send messages to other users, the contract stores a complete
history with the record for future reference. Messages can be viewed at any time.
You can send messages as you navigate through a contract by clicking a contact’s name if it
displays as a hyperlink or using the Messages buttons that display at the bottom of a page.
Examples:


When viewing an amendment, click the contact’s name to send a message to that contact.



On the Subs page, use Message All or Message All Subs to send a message to contractors.
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When on the Compliance Audit Summary or Compliance Audit FY tabs, you can click the
contact’s name to send a message to that contact.

To send a message
1. If necessary, open the contract from which you want to send a message.
2. Navigate to one of the tabs or pages listed above.
3. Depending on the page you accessed, click the contact’s name, the Message All
button, or the Message All Subs button.
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4. In the Message field, enter the message, and then click Review/Next.

5. Click Send.
WARNING:

Sent messages cannot be deleted or recalled.

Managing contract reviews
On the Contract Management: Reviews page, you can view all of the reviews associated with
the contract, if any.
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Managing site visit reports
On the Contract Management: Site Visits page, you can add details about a site visit and view
and edit the details for existing site visits.

To create a site visit report
1. If necessary, open the contract for which you want to add a site visit.
2. Click Add Site Visit.
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3. In the Site Visit Conducted area, specify whether the site visit was completed.

4. To specify details about a site visit, complete the following:
Site Visit Date: Use the calendar selector to specify the date on which the site visit
occurred.
Person Conducting Site Visit: Enter the name of the person who conducted the site
visit.
Location(s): Enter location details.
Attach File(s): Use to attach documents, as necessary.
Comments 1, 2, 3: Enter additional comments, as necessary.
5. Click Review.
6. Click Save.
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Running reports
On the Contract Management: Report List page, a list of reports you can generate for this
contract displays. You can run the report by clicking a report title.
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Closing contracts
On the Contract Management: Close Contract page, you can view contract details in
preparation for closing a contract. If the payments have been reported and confirmed, and the
contract is complete, you can use the fields to close the contract.
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When a contract is complete, it must be closed. A CCO can close a contract when necessary.
Additionally, prime contractors can indicate on their audits that it is time for closeout. On the
Dashboard, there is a row for Closeouts and Final Audits. Click the number to view the
contracts for which a prime contractor indicated a final audit.

TIP:

A incomplete compliance audits must be cleared, along with any
discrepancies, before a contract can be closed.

To close a contract
1. If necessary, locate and open the contract.
2. On the Contract Management page, click the Closeout tab.
3. Click Close Out Contract.

4. Click OK to confirm you want to close the contract.

Printing contract close letters
You can send Contract Close Letters to request verification from vendors or to notify parties
that the contract was closed
To generate a single letter
1. If necessary, locate and open the contract.
2. On the Contract Management page, click the Closeout tab.
3. Click the Print Letter hyperlink.

4. Review and edit information, if necessary.
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5. Click Print Letter for the template you want to use.

To generate all letters
1. If necessary, locate and open the contract.
2. On the Contract Management page, click the Closeout tab.
3. Click Print All Subcontractor Close Out Letters.

4. Click OK to confirm you want to print all letters.
5. Click Print Letters for the template you want to use.

NOTE:

If you generate multiple letters at once, you cannot edit the data for an individual letter.
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Sample Contract Close Letter
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Contract Compliance Payment Auditing
Understanding the audit process
After a contract has been created and your organization begins making payments to the prime
contractor, the contract is ready for auditing. Contract settings determine whether audits are
generated monthly, per payment, or on demand. The following image represents the audit
process.

Your organization pays
the prime contractor.

The subcontractor
receives an email
indicating there is an
audit they must respond
to.

The prime receives an
email indicating there is
an audit they must
respond to.

The subcontractor logs
into the system and
confirms the payment(s)
made to them by the
prime.

The prime logs into the
system, confirms the
payment, and reports all
payments to the subs.

The audit is complete for
the period. The cycle
continues for each
payment until the
contract is complete.

On the Compliance Audit Summary tab, you can view contract progress to date. The summary
compares the awarded amounts to the actual payments. If the prime contractor meets or
exceeds the contract goal, the progress bar is green. If the prime contractor misses the goal, the
progress bar is red.
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Viewing the Audit History
On the Contract Management: Audit History page, you can view all of the contract’s
compliance audits. You can also view the status for each audit, as well as the summary
payment information for the prime contractor and subcontractors. Access additional payment
information by clicking the hyperlink for the audit period.

In the Audit History area, items marked in red indicate that information is incomplete or there
are discrepancies. The following audit summary displays the payment information for a
specific time period.
To view audit history
1. If necessary, locate and open the contract.
2. From the Contract Management page, click the Compliance Audit List tab.
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Viewing the Audit Summary
On the Contract Audit: Audit Summary for Total Contract page, you can view the total
payments your organization paid to the prime contractor and the reported payments the prime
contractor paid to the subcontractors. Based upon the status of each vendor, the contract
goal(s) and actual participation rate(s) are compared in real‐time. Certification information
displays from the Certified Directory.
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If a prime contractor is not meeting the project’s diversity goals, as listed in the Contract
Settings area of the Contract: View page, the audit summary shows the payments made to
subcontractors as “below goal.” You can generate and send a letter to the prime contractor,
notifying the contractor of the goals and expectations for the contract.

To view an audit summary
1. If necessary, locate and open the contract.
2. On the Contract Management page, click the Compliance Audit Summary tab.

Page 3‐48

B2Gnow Support  support@b2gnow.com

CONTRACTS

Viewing the Fiscal Year Audit Summary
On the Contract Audit: Fiscal Year Audit Summary page, you can view an audit summary for
the contract’s fiscal year, including payments made towards subcontractors for meeting the
goals set forth in the contract.

To view a fiscal year audit summary
1. If necessary, locate and open the contract.
2. On the Contract Management page, click the Compliance Audit FY tab.
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3. If the contract spans multiple fiscal years, you can navigate to other years by clicking
the View Previous Fiscal Year or View Next Fiscal Year Audit buttons.

Managing Compliance Audits
To view a compliance audit
1. On the Contract Management: Audit History page, click the View Audit hyperlink for
the period for which you want to view payment information.
2. To view the previous or next audit, click one of the buttons to advance to the previous
or next pages.
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Adding a missing audit
Depending upon the module configuration, you may need to manually add an audit. You must
add the audit before you can add payment information.
To add an audit
1. On the Contract Management: Audit History page, click the Add Audit hyperlink for the
period for which you want to add audit information.

2. Click OK to verify you want to add the audit.

3. Specify whether you want to notify the prime contractor that you are adding an audit.

NOTE:

If you click OK, the prime contractor receives an email notification instructing them to
report the subcontractor payments. If you click Cancel, the prime contractor will not receive
a notification, but the audit will be created.
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Entering prime and sub contractor payment information
After adding a missing audit, you can enter payment data for the contract’s prime and sub
contractors. If your prime payment data is imported from your financial system, you do not
need to manually enter it.
You can also edit payment information.
NOTE:

If your payment data is imported, you receive a warning alert if you try to edit the prime
contractor payment. You may continue, but you should determine why the payment
amount is incorrect or missing before making any changes.

To add (or edit) prime contractor payment information
1. On the Contract Management: Audit History page, click the View Audit hyperlink for
the period for which you want to add payment information.
The Contract Audit: Audit Summary page displays for the selected audit period.
2. In the Payment to Prime area, click the Submit hyperlink.

NOTE:
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If prime payment information has already been imported from an external financial system,
the link will be Edit.
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3. In the Amount field, enter the payment information.

4. In the Comments field, enter information about the payment.
5. Click Save.
6. Click OK to confirm you want to add the payment.
To add subcontractor payment information
1. On the Contract Audit: Audit Summary page, in the Subcontractors area, click the Edit
hyperlink.
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2. In the Amount PAID field, enter the payment information.

3. From the Payment Date calendar, select the date on which the payment was made.
4. Click Review.
5. If the information is correct, click Save.
Once each subcontractor has confirmed the payment, the audit is complete.
NOTE:

In most cases, the prime contractor will report its subcontractor payments. The CCO needs
to add or update subcontractor payments only if the prime is unable to do so.

Resolving a discrepancy
If a prime contractor and subcontractor disagree on an amount paid, the system creates a
discrepancy. The system sends an email message to the vendors to notify them of the issue
and request they self‐resolve the discrepancy. If they are unable to resolve the discrepancy,
the Contract Compliance Officer (CCO) may be required to take action.
To view the discrepancy, you access the Discrepancy Resolution screen, which displays contact
information for the CCO, the prime, and the subcontractor. It is the vendor’s responsibility to
contact the CCO for assistance in resolving the discrepancy. The comments from the prime and
the subcontractor are visible on this page. Timing of the billing cycle and payment reporting
are the two most common causes of discrepancies.
When both parties agree to a resolution, they can complete the process themselves, or the CCO
can finish the discrepancy resolution by clicking Resolve Discrepancy and then completing the
form.
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Your Dashboard displays total discrepancies.

Click any number to view the list of discrepancies.

To access a discrepancy
1. On the Diversity User Control Panel: Contract Audits page, in the Audit Period column,
click the hyperlink for the time period you want to view.
The Contract Audit: Audit Summary page displays for the specified time period.
2. In the Subcontractors box, click either Resolve link.
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3. Review the information and work with the parties to determine and resolve the
situation.

4. When the final data is complete, click Resolve Discrepancy.
5. In the Discrepancy Resolved area, select an option, and if necessary, enter the final
amount.
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6. To include comments or files, enter or attach them, as needed.

7. Click Save Response.
8. Click OK to confirm you want to save the resolution information.

Audit management
There are four buttons on the contract audits that you can use to maintain your contract audits.

Mark Remaining Prime Entries as Zero – Indicates the prime contractor has not made any
subcontractor payments or the remaining incomplete audit lines are $0. Click the button to
complete the audit lines with $0.
Mark Unconfirmed Sub Entries as Confirmed – Indicates one or more subcontractors have not
confirmed their payments. This button confirms all incomplete audit lines. If a subcontractor
has completed work, edit the subcontractor record to indicate that the final payment was
received. The subcontractor will not be included in future audits.
Submit All Incomplete Records – Allows you to bulk enter subcontractor payments. You can
only use this function the first time a subcontractor payment is recorded. Payment edits must
be done individually.
Extend Reporting Deadline by Two Weeks From Today – Extends the reporting deadline by
two weeks. The prime contractor can enter payments and the subcontractors can confirm
payments. The reporting time period varies depending on your organization’s preference and
is usually 15 to 90 days.
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Extending a reporting deadline
When audit data becomes available for reporting, both prime contractors and subcontractors
have a set amount of time to respond before the audit closes. The time period varies
depending on your organization’s preference and is usually 15 to 90 days. There are times
when vendors will miss the reporting deadline or need to correct amounts they reported in
previous months. Depending on your access rights, you can extend the reporting deadline in
two week intervals to allow vendors to report their payments.
To extend the reporting period for one audit period
1.
2.
3.
4.

If necessary, locate and open the contract.
On the Contract Management page, click the Compliance Audit List tab.
Click the View Audit hyperlink for the time period you want to extend.
Click Extend Reporting Deadline By Two Weeks From Today.

5. Click OK.
To extend the reporting period for all audits on the contract
1. If necessary, locate and open the contract.
2. On the Contract Management page, click the Compliance Audit List tab.
3. Click Extend Reporting Deadline By Two Weeks From Today.

4. Click OK.
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B2Gnow Data Import Process
If your organization’s implementation includes an automated contract data interface with your
financial system or project management system, data is imported on a regular basis into
B2Gnow. However, external systems typically contain only a few data fields relevant to the
contract compliance process, and it is necessary for staff to review and update the imported
data.
NOTE:

During the import process, the B2Gnow system will not overwrite any data that was
manually entered or updated.

Data comes into B2Gnow from a wide range of systems in varied formats. The records must
first be processed through a filter to ensure that they are correctly and consistently structured
for the B2Gnow Import Engine.

FTP Server

External DB

File
Server
Save
file to
File
Server

Quarantine
Server

Task Server

Save
bad file to
Quarantine
Server

File Server

Interface DB

Core DB

Save
XML file
to File
Server
Validate record
Interface
Record
Load record into
Interface DB

Firewalls

External DB
creates extract
data files

Original data file
is preprocessed
into standard
XML file

Files placed on
FTP Server

Data Manager
views and edits
failed import
records

Final
Record
Import record

Staff views and
edits final record

SysAdmin
oversees process

SysAdmin

Data Manager

Staff

Records are validated for required fields, data format, and field length, and they are rejected
for a number of reasons. Once a contract or vendor record is added to the system, it is
assumed that it is then controlled by a user and no further updates will be made to that record,
except to flag specific changes relevant to the contract compliance process.
NOTE:

Corrections to rejected data imported from an external system should be made in the
source system to ensure that future data imports do not contain the same errors.
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Importing Prime Contractors
The first step of importing a contract header is to add the prime contractor record to the
database. The vendor record may already exist due to a prior import or manual entry;
otherwise it must be added from the data file. If a prime contractor import record is rejected,
the associated contract header record will also be rejected and not loaded until the prime
record is corrected and imported.

Reasons for rejection








Missing company name
Missing contact information (email/fax)
Missing contact person
Missing FEIN
Missing financial system vendor number
Mismatched data with an existing record
Same company with multiple duplicate records in external system

Correcting rejected prime contractors
If a prime contractor record is rejected, action must be taken to correct the data. The
correction can be made in B2Gnow, the vendor record can be added manually, or the
correction can be made in the external system and resubmitted in the next data file.
To correct the prime contractor data
1. From the Tools menu, open the Data Management sub‐menu, and then click Vendors.
2. Adjust the Date Imported Range, and then click Update Statistics.
The Import Statistics box summarizes the results of data import.

3. To view and correct rejected records, click View Rejected Records. If no link is visible,
no records need correction.
The Imported Records List displays the relevant records.
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4. Adjust the Date Imported Range, resort the list, or change the filters to refine the list.

5. To view a record, click View.
The view page displays the entire vendor record and lists all errors with required and
optional fields. Review the errors closely.
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6. Click Edit Record & Resubmit to correct the record.
The list of errors is repeated for reference, followed by editable fields for every field on
the vendor record.
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7. Correct the data and click Resubmit Record.
The record is validated and imported during the next hourly import cycle.

NOTE:

If a rejected record is edited, care must be taken to resubmit the record with correct data.
The system limits the entry of invalid data; however, organization‐specific fields may require
certain data formats that are not verified on screen. Invalid data could cause the record to
be rejected again.

Some rejected records may not need to be addressed. Delete these records from the list to
remove them from the rejected status count.

Vendor matching process
The vendor record in the data file is compared to the full vendor database using all available
fields. A sophisticated algorithm compares the information, determines the possible matches,
and scores the quality of each match. Certain fields, such as FEIN and financial system vendor
number, result in very high scores. Matches on other fields, including email, phone, fax,
business name, and address, result in low scores. A combination of low scoring fields, such as
email, fax, and business name matched at the same time can generate a higher aggregate
score. If a certain score threshold is reached, then the system has determined that the
company is already in the database.
When a match is made, certain organization‐specific fields are updated. However, general
business and contact information, including business name, phone, fax, email, contact person,
and address are not updated as this can potentially overwrite data that vendors or staff are
updating themselves in the system.
If a match is not made and the vendor is new, it is added to the database.
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Importing contract headers
The second step of importing a contract header is to add the contract record to the database.
The contract record may already exist due to a prior import or manual entry. If not, it is added
from the data file. Like the prime contractor record, the contract header record is assessed and
can be rejected for certain data issues.

Reasons for rejection






No contract title
No start date
No end date
No value
Prime contractor not in the system or could not be matched

Correcting rejected contract headers
If a contract header record is rejected, action must be taken to correct the data. The correction
can be made in B2Gnow. The contract record can be added manually, or the correction can be
made in the external system and resubmitted in the next data file.
To correct a contract header
1. From the Tools menu, open the Data Management sub‐menu, and then click Contracts.
2. Adjust the Date Imported Range, and then click Update Statistics.
The Import Statistics area summarizes the results of data import.

3. To view and correct records, click any of the links. If no link is visible, no records need
correction.
The Imported Records List displays the relevant records.
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4. Adjust the Date Imported Range, resort the list, or change the filters to refine the list.

5. To view a record, click View.
The view page displays the entire contract header record and lists all errors with
required and optional fields. Review the errors closely.
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6. Click Edit Record & Resubmit to correct the record.
The list of errors is repeated for reference, followed by editable fields for every field on
the vendor record.

7. Correct the data and click Resubmit Record.
The record is validated and imported during the next hourly import cycle.

NOTE:

If a rejected record is edited, care must be taken to resubmit the record with correct data.
The system limits the entry of invalid data; however, organization‐specific fields may require
certain data formats that are not verified on screen. Invalid data could cause the record to
be rejected again.

Some rejected records may not need to be addressed. Delete these records from the list to
remove them from the rejected status count.
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Contract matching process
The contract header record is matched to the contract database on a single field: contract
number. If a match is not found, the contract is added to the system and marked as a “new
record”. During processing, the contract header record is matched with the previously
imported prime contractor record.
The fields present on a contract header are a small fraction of the data that is critical to the
contract compliance process. It is important, therefore, to review the imported record and
complete the “lock‐in” process. This involves opening the record, correcting erroneous
information, and adding any additional parameters that are relevant to the contract compliance
process.
If a match is found, the algorithm determines if a critical change has been made to the contract
header and updates the system accordingly. Critical changes to the contract header are
changes in value and/or end date.
If the value of the contract has changed, it is likely due to a change order or amendment to the
contract. The contract in the system will be flagged and the new value marked on the record,
which may be more or less than the original value. The actual value on the contract will not be
changed as the adjustment may involve other changes that are not detailed in the contract
header data feed and must be manually addressed. Contract value changes are usually
accompanied by a modification to the subcontractor utilization plan, which must be addressed
on a case‐by‐case basis.
In addition, the end date may be adjusted due to the circumstances of the contract. This
change may be associated with a value change.
On a regular basis, the Contract Compliance Officer (CCO) must review all new contracts, value
change alerts, end date change alerts, and rejected records. All actions should be taken prior to
the next loading of data to ensure that changes to records are done in a consistent manner.
NOTE:

Once a contract record has been added to the system, future copies of that contract in the
data feed are used only to assess value and end date changes. No other fields are assessed
or updated. Furthermore, the import process never automatically updates any fields;
changes are flagged for review by the CCO.
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Locking in new contract records
New contract records in the system must be “locked in” before they can accept contract
payments.
To view all new records
1. From the View menu, click Contracts.
2. From the Actions list, select New Contract.

To lock in a new record
1. Click the contract title to view the record.
The second box displays all contract alerts in red. If the contract is a new record, the
alert “Contract record is new and must be reviewed for accuracy” will be listed.
2. Click review contract.
An alert displays to provide instructional information.

3. Click OK.
The contract edit page displays with the contract header data from the import auto‐
filled into the fields. Many fields will be blank or zero.
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4. Review the entire record and update as needed. When finished, click Review at the
bottom of the page.
5. When reviewing the data, do the following:
 Verify contract title/description
 Verify value of contract
 Verify prime contractor
 Verify (and change, if necessary) the buyer/project manager
 Assign to a contract compliance officer
 Add contract goals
 Add funding sources and amount (important for DBE FTA/FAA/FHWA funded
projects)
 Verify audit settings
 Add notes
 Select/enter values for organization‐specific fields
 Attach electronic documentation
6. Review the record on the next page.
7. To make changes, click Edit.
8. To save the record, click Save.
Adding subcontractors
If the contract has certified or non‐certified subcontractors, add them from the Subs tab.
Subcontractors should be added before auditing commences. Refer to Adding a subcontractor
to a contract for instructions.
Missing contact information for prime contractor
Sometimes the prime contractor record provided by the external system does not have
contact information. To communicate with the prime contractor regarding contract
compliance audits, the system must have a valid email (or fax, if fax service is selected) for the
point of contact. If no contact information is found, an alert displays on the Contract
Summary page.

To update prime contractor contact information
1. Click the edit link in the alert.
The user edit page displays.
2. Complete the missing contact information and click Save Changes.
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To view all contractors that are missing critical contact information, run the report: Contracts
Import ‐ Contractors Missing Contact Information. This report will list all contractors with
current contact information for the assigned point of contact, the notification method
selected, and the instructions to update the vendor account.

Working with Certified, self‐performing prime contractors
If a prime contractor is certified and will be counted towards the goal, the contract must be
updated to reflect this status. For instructions, refer to Certified, self‐performing prime
contractors earlier in this chapter.
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Editing records flagged with new values
The value of a contract is regularly adjusted up or down through change orders and
amendments as the scope of the project changes. If the system detects a value change, the
contract record is flagged for review. The original value will not be automatically updated as
there are many reasons for the change and a manual review may be required.
To view all contracts with new values
1. From the View menu, click Contracts.
2. From the Status list, select New Value.

To review and update a contract value change
1. Click the contract title.
The second box displays all contract alerts in red. The old and new contract values
display.

2. Research the change with the contracting department.
3. If the value change is a mistake, click deactivate alert. If the external system is not
corrected, future imports may trigger the new value flag again.
4. If the value change is correct, click update value.
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5. Complete the amendment/change order form and save the record to update the
contract value. This process also accounts for changes in the subcontractor utilization
plan. Refer to Submitting an Amendment/Change Order for instructions.
NOTE:

Do not edit the contract to change the value, except in cases where the value on the record
is incorrect. The amendment/change order process captures important changes to the
subcontractor utilization plan.

Editing records flagged with new end dates
The end date of a contract is often adjusted to reflect change orders and amendments as the
scope of the project changes. If the system detects a value change, the contract record is
flagged for review. The original value will not be automatically updated as there are many
reasons for the change and a manual review may be required.
To view all contracts with new end dates
1. From the View menu, click Contracts.
2. From the Status list, select New End Date.

To review and update a contract end date
1. Click the contract title.
The second box displays all contract alerts in red. The old and new end dates display.

2. Research the change with the contracting department.
3. If the value change is a mistake, click deactivate alert. If the external system is not
corrected, future imports may trigger the new end date flag again.
4. If the end date change is correct, click update end date.
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5. Complete the Extend/Shorten Contract form and save the record to update the
contract end date.

NOTE:

Do not edit the contract to change the end date, except in cases where the end date on the
record is incorrect.

Processing contract value and end date changes
It is common that an amendment/change order involves both a contract value and end date
change. In this situation, process both changes separately until all alerts on the records are
cleared.

Multiple Record Updates
If changes to contracts are not reviewed and updated before the next import file is received, it
is possible that another change made to the contract will be received in the next import. The
system continues to use the original contract value and end date as the baseline comparison
data, but it only retains the most recent import update. For example,
Import Data

System Value

Original import and record lock‐in

$1,000,000

$1,000,000

No

First update import file

$1,100,000

$1,000,000

Yes

$1,100,000

Second update import file

$1,200,000

$1,000,000

Yes

$1,200,000

$1,200,000

No

Contract change order submitted
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In the example, the flagged alert from the first update import file is not processed before the
second file is received. Once the second import file is received, the record will be re‐flagged
and a new value of $1,200,000 noted. The $1,100,000 value will no longer be available in the
database or visible on the screen.
In this situation, there are two options. The first is to submit a single amendment/change order
that captures the entire value of all changes. The second is to submit an amendment/change
order for each actual change. In either case, care must be taken to accurately reflect the actual
subcontractor utilization plan after all changes are saved. In some implementations, a series of
contract files will be loaded, resulting in multiple changes made on a contract record. Typically,
a single amendment/change order will suffice to catch‐up the record to the go‐live point.

Viewing summary reports
To provide a snapshot of all contracts that require review, a summary report is available. The
report, Contracts Import ‐ Imported Records for Processing, will provide:
1. New contracts that require review and “lock‐in”.

2. Contracts that have been flagged with a value change.

3. Contracts that have been flagged with an end date change.
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4. Contracts that were rejected during the import process.

Imported contract payments
One of the biggest positive impacts on organization efficiency is B2Gnow’s ability to update
contract payments. Periodic import of payment data eliminates the need for staff to manually
update records. B2Gnow automatically handles all aspects of contract compliance audit
creation and payment update. Contract payments go through a validation and import process
similar to the contract data feed, and records can be rejected for certain issues.

Reasons for rejection




No payment date
No payment amount
No contract number

Editing rejected contract payments
If a contract payment is rejected, action must be taken to correct the data. The correction can
be made in B2Gnow, the payment record can be added manually, or the correction can be
made in the external system and resubmitted in the next data file.
To edit a rejected contract payment
1. From the Tools menu, click Data Management, and then click Contract Payments.
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2. Adjust the Date Imported Range and click Update Statistics.
The Import Statistics area summarizes the results of data import.

3. To view and correct records, click any of the links. If no link is visible, no records need
correction.
The Imported Records List displays the relevant records.
4. Adjust the Date Imported Range, resort the list, or change the filters to refine the list.
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5. To view a record, click View.
The view page displays the entire vendor record and lists all errors with required and
optional fields. Review the errors closely.
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6. Click Edit Record & Resubmit to correct the record.
The list of errors are repeated for reference, followed by editable fields for every field
on the vendor record.

7. Correct the data and click Resubmit Record.
The record will be validated and imported during the next hourly import cycle.

NOTE:
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If a rejected record is edited, care must be taken to resubmit the record with correct data.
The system limits the entry of invalid data; however, organization‐specific fields may require
certain data formats that are not verified on screen. Invalid data could cause the record to
be rejected again.
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Some rejected records may not need to be addressed. Delete these records from the list to
remove them from the rejected status count.

Contract payment matching process
Validated contract payments are matched to their contracts using the contract number on both
records. If the contract header is missing a contract number or there is a discrepancy between
the contract number on the contract header and payment record, the payment will not be
matched.

Contract compliance audits
If payments are provided for a time period that does not have an existing contract compliance
audit in the system, a new audit record is created. This process continues as long as the
contract is open. Upon contract close, no further audits are created.
NOTE:

Audits are not automatically created on a contract when:
 the contract is new and has not yet been “locked‐in”
 the contract has been closed and is no longer accepting audit data

Handling payment detail and multiple payments
Once a match has been made with an existing contract and the import process has confirmed
that an audit exists, the payment data is added to the audit record.
Monthly Audit Period
If a contract is configured for a monthly audit period, all payments during the month are
aggregated and added to the audit as a single number. The payment detail is included as part
of the record. In the example, three payments were made on the contract during the month.
The audit is updated with a total paid amount of $45,599.86, and the three payments are
added to the detail record. The final date of payment is noted on the audit as March 28.
Amount

Date

Payment #1

$7,196.95

March 21

Payment #2

$1,079.51

March 25

Payment #3

$37,323.60

March 28

Total for Audit

$45,599.86

March 28
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Per Payment Audit Period
If a contract is configured to audit each payment, an audit is created for every payment
regardless of the value. In this circumstance, the example above would instead generate three
contract compliance audits, each on its own date with an amount matching the payment.
Amount

Date

Payment #1

$7,196.75

March 21

Total for Audit #1

$7,196.75

March 21

Payment #2

$1,079.51

March 25

Total for Audit #2

$1,079.51

March 25

Payment #3

$37,323.60

March 28

Total for Audit #3

$37,323.60

March 28

Ignored contract payments
Once payment information has been added to a contract compliance audit, no further
automated updates to that audit will be accepted by the system. Further payments for that
time period are ignored. If a payment is added manually to an audit prior to the automated
import of payment data, the manual addition will lock out the imported data.
If a contract is closed, new payments are ignored. Therefore, it is important to close a contract
only when all expected payments have been reported. If there is a payment after the close
date, it is necessary to manually update the record.

Using the Payments Not Imported report
To provide a snapshot of all payments that were not imported, run the Contracts Import ‐
Contract Payments Not Imported report. It details total payments against each contract not
imported due to:




Missing contracts
Already locked audits
Closed contracts

If further payments are received but not imported, the amounts are incremented automatically
after each import cycle.
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From the report, an example of payments made on contracts not currently in the system:

From the report, an example of payments made on contracts currently in the system, but either
the contract is closed or the payment information has already been manually entered:

Using the Data Import Checklist
It is important to regularly review and update the imported data. After each import cycle, use
the following checklist to ensure that that all information is up‐to‐date.
1. Review rejected prime contractor records and correct for re‐import.
2. Run Contracts Import ‐ Imported Records for Processing report for a complete listing of
all imported and rejected contract records.
3. Review rejected contract header records and correct for re‐import.
4. Lock in all new contract header records and add subcontractors.
5. Run Contracts Import ‐ Contractors Missing Contact Information report and update
vendor records as instructed.
6. Research contracts with new values and create change orders/amendments as required.
7. Research contracts with new end dates and create change orders/amendments as
required.
8. Review rejected contract payment records and correct for re‐import.
9. Run Contracts Import ‐ Contract Payments Not Imported report and add contracts that
are missing from the system.
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